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1. Introduction 

The ALL0819 Utility program provides a PC-based, user friendly interface to control the 
ALL0819, enables users to access, monitor, and configure the ALL0819 device, an IP-based 
device which let users share and remote control the USB device connected to it. 
 

Features: 
 Centralized remote ALL0819 management  
 Centralized remote ALL0819 status monitoring  
 Centralized remote USB device management  
 Centralized remote USB device status monitoring  
 

1.1. System Requirements 

Operating System Microsoft Windows® XP or Vista 
CPU Intel Pentium® III or better, clock rate faster than 1.7GHz 

recommended 
RAM At least 512MB 
Screen Resolution Any resolution 
Free Disk Space At least 20MB  
Network Interface At least one Fast Ethernet (100 Mbps) network card, and Ethernet 

Cord 

1.2. Installation 

Please insert the Utility CD-ROM into the computer’s CD-ROM drive. The CD will launch 
a browser for installation. Click the necessary link to start installation:  
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The following dialog box should pop up to prompt you the InstallationShield wizard. 

Please follow the instructions of the wizard to complete the installation process. And please 
reboot the system after the installation process finishes. Otherwise the program will 
not work properly. For Windows Vista users, please click Continue to proceed in any User 
Account Control message appeared during installation. 
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1.3. Run the Program 

After successful installation and restart, please run the ALL0819 Utility Program from the 
Start / All Programs or double-click the utility icon on the desktop.  

 
This brings up the main dialog: 
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2. How to use 
ALL0819 Utility’s main dialog box is as shown above in Section 1.3. It consists of a Menu (File, 
View and Help), a tree view, a ”Search” button to get the current status of the ALL0819 and USB 
device on the network, and a button that toggles between “Config” and “Connect” depending on 
the node you select on the tree view. On the tree view, it toggles to “Config” when a ALL0819 
device is selected and “Connect” when a USB device is selected. The tree view displays the 
ALL0819 and USB device currently your PC has access to.  
Note: You can set an alias name for each ALL0819s for easy recognition. The alias name 
with its IP address will be displayed on the tree view. The detail is described in p.17. 

2.1. Status of ALL0819 and USB device 

The tree view tells you the status of the ALL0819 and USB device that are accessible to you. An 
ALL0819 is either accessible or inaccessible. An inaccessible ALL0819 is either disconnected 
from the network, powered off or suffers other technical difficulties that prevent it from being 
accessed by your PC. Inaccessible server will not appear on the tree view.  
Accessible ALL0819s have several kinds of status: 

Status Screenshot Note 
Ready 

 

An ALL0819 
with “Ready” 
status is 
indicated by a 
square green 
icon. This 
green icon 
indicates this 
device is 
unoccupied 
and ready to be 
connected. 
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Occupied 
by 
Yourself 

 

When you 
successfully 
connect to a 
ALL0819, the 
green icon will 
turn into orange 
to indicate the 
connection is 
established. 

Occupied 
By Other 
User 

 

The red icon 
indicates this 
ALL0819 is 
currently 
occupied by a 
specific user 
and cannot be 
accessed by 
other users at 
this moment. 

:Device on Different Segment  

Blue icon indicates the ALL0819 and the PC’s IP addresses are of different network segment. To 
access the ALL0819, you need to modify the ALL0819 and the PC’s IP addresses to be in the 
same network segment. 
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:Unsupported Device  

Some USB devices may not be supported by the ALL0819. Such USB device will be identified by 
a red X icon and connection cannot be established. 

:Self Occupied with Error  

A yellow exclamation mark indicates error happens on the device you are connecting to. Possible 
scenarios: the device is a printer and it is out of ink or out of paper. 

:Occupied by Others with Error  

A red exclamation mark indicates error happens on the device occupied by another user. 

:Free with Error 

A green exclamation mark indicates this device is not connected by anyone but does have some 
type of problem such as out of ink. 
 
Regardless of color, exclamation mark indicates the device is not working normally. Please 
resolve the problem before continuing using the device. 
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2.2. Accessing a device 

Please follow the steps to connect a USB device: 
1. Select the desired device on the tree view. 
2. Click the “Connect” button or double-click its name on the tree view to access it. 
This process might take a few seconds to a minute, depending on the device’s complexity. Once 
connected, you can use the USB device as if it were directly connected to your PC via USB 
cable. 

 

 

After selecting a connected device on the UI, the Connect button will be changed to Disconnect: 
  

Click the 
“Connect” 
button or 
double-click 
the device’s 
name on the 
tree view to 
access it 
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Clicking on the “Disconnect” button disconnects you from the selected device. Once you see the 
icon turns green, the device has been disconnected and other users will then be able to access it. 

2.3. Server Configuration via web interface 

The ALL0819’s setting is configurable via web interface: 
1. Select the desired ALL0819 on the tree view. 
2. Click the “Config” button, or right-click its name on the tree view and select the “Config” menu 

item on the pop-up menu.  
3. Your default web browser will pop up and bring you the web-based configuration UI of the 

ALL0819. 

 
Below is the main page of the web-based configuration UI. You can see the important information 
about the ALL0819 and the device(s) connected to it. Each of the left frame’s 6 links represents a 
function. Clicking the link “Device Status” brings you back to this page, and the 5 other links take 
you to pages with different functions. 
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Network Information/Setting 
This page displays the current network setting of the ALL0819 and provides links to the pages 
where you can perform special actions.  
1. Change “Server Name”: The server name shown on the Utility consists of 2 parts. The rear 

part after hyphen represents the last 6 digits of this device’s MAC address, while the front part 
before hyphen is configurable, and is shown here. Please input the intended new “Server 
Name” (front part) here. 

 
2. Change IP address: Please make sure the input values are reasonable, and suit your 

environment. Once done, please click the “Submit” button and reboot the server.  
NOTE: Configuration to an ALL0819 with busy device(s) is prohibited to avoid 
interruption of any ongoing tasks. Please unplug USB device before configuration. 

front part 

rear part 
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Please input the intended 
new “Server Name”(the 
front part of the server 
name shown on Utility) then  
click “Submit” 

After successful 
submission, the updated 
network name is shown 
here 
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Server Reset 
You can reboot the ALL0819 with the “Reset Server” button. Password is blank by default (and 
therefore do not need to be entered), but if it is set beforehand, it must be entered to enable the 
reset. This function only restarts the device and does not change any configuration item. Before 
reset, please unplug Ethernet cord and USB device from ALL0819. 

 
Factory Default 
Clicking the button “Factory Default” on the web page or push and hold the “RESET” button for ≧ 
3 seconds to restore this ALL0819’s settings to factory default values: 

(1) IP configuration: back to the default “DHCP mode”. 
(2) Password: back to the default blank. 

A reboot is automatically performed during the factory default process. If the password is set 
beforehand, it must be entered to enable the factory reset. Before factory reset, please unplug 
Ethernet cord and USB device from ALL0819. 
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Update Firmware 
Steps: 
1. Click “Browse” button to browse the firmware file you would like to upload.  
2. Click “Submit” button to update the selected device’s firmware.  
In web interface, the eligible firmware file for upload is the 16KB firmware kernel file. For complete 
upgrade of the whole firmware image, please refer to p.17: “Upgrade firmware via Utility program”. 
Password is blank by default (and therefore do not need to be entered), but if it is set, it must be 
entered.  

 

Change Password 
To change the password, you must enter current password, input new password and re-input new 
password for confirmation and then click “Submit”. If you are setting the password for the first time, 
you don’t have to provide current password. The allowed password format is 1~31 alphanumerical 
case-sensitive characters. 
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2.4. ALL0819 Configuration via Utility 

Another way to configure the ALL0819 is directly via the ALL0819 Utility’s functionality. Please 
right-click on the device you would like to configure and select the “Setting” menu item.  

 
If a password has been set, please enter password for authentication. The configuration dialog will 
show up after entering correct password, or directly pop up if the password is blank. 
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Set Server Name and IP Address:  
These fields allow you to set the ALL0819’s name (an alias for easy recognition) and IP address. 
You can apply this function to ALL0819s in different network segment. This item’s 
functionality is exactly the same as its web-interface counterpart “Network Information/Setting” 
shown on p.11~12. Please click the button “Set” after you assure the input values are reasonable. 



 
 

     17 

 

If “Server Name” is modified, the Server Name will be immediately updated on the Utility program, 
and the change is also observable on the web interface (cf. p.11~12 “Network 
Information/Setting“ section). Server Name modification performed on web interface is also 
observable on the Utility program. 
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Backup Firmware: This function is a fail-save mechanism for updating the ALL0819’s firmware. 
Use the Browse button to choose your intended directory to save the backup file. Click the 
Submit button to start. You can backup the current firmware of the selected ALL0819 and save it 
on the PC in case of erroneous update or update failure. 

 
Update Firmware: Use the Browse button to choose the firmware file to update. Click Submit 
button to start. Unlike web interface, the eligible firmware file for update here is the 513KB 
firmware image file.  
 

 
Change Password: Enter the new password and re-enter it for confirmation. Click Submit button 
to change. Leave both fields blank will make the password blank. The allowed password format is 
1~31 alphanumerical case-sensitive characters. 

 

Reset Server:  This button reboots the server. Please note that this function will not work if the 
ALL0819 you attempt to reset currently has device(s) connected to it (to avoid interruption of any 
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ongoing tasks). Please unplug Ethernet cord and USB device from ALL0819 before reset. This 
function only restarts the device and does not change any configuration item. 

2.5. Polling Interval 

The ALL0819 Utility program periodically polls your network to find out the status of the connected 
ALL0819 and USB device. Changes on the device’s status will be updated to the tree view in the 
main dialog box. Click the File -> Settings -> Polling Interval on the main menu to change the 
interval setting. 
A minimum of 20-second interval is required. Set the interval to 0 disables this function. Click 
Submit button to take the setting into effect. 
 
 
 
 
 
 
 
 
 
 
 
 

2.6. Language 

The ALL0819 Utility supports 6 languages as illustrated. Please go to File -> Settings -> 
Languages to select your desired language. 
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2.7. Search 

Click “Search” button to update the newest status of the ALL0819 and USB device immediately. 
The program will immediately poll the network and update the tree view. 
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2.8. View 

The tree view in the main dialog has two display modes: “Servers and Devices” mode and 
“Devices Only” mode. The default mode is “Devices Only”. You can toggle between these two 
modes using the “View” option on the control menu: 

 
Servers and Devices view 

 
Devices Only view 

2.9. Device Details 

A “Detail” menu item will pop up when you right click on a device on the tree view. The selected 
device’s detailed information will be displayed after clicking this menu item. 
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2.10. Help -> About 

About option displays legal, version and copyright information. 



 
 

     23 

 
 

3. FAQ 

3.1 General Questions 

Q. How come I don’t see any ALL0819 on the tree view after installation?  
Ans.:  Besides the obvious hardware reasons that your PC or the ALL0819 is not normally 
connected (e.g. loose wire), enabling firewall or anti-virus software on your PC might block the 
ALL0819 Utility’s normal data accessing from the network. Please disable all your firewall or 
anti-virus software before using the ALL0819 Utility program. 
 
Q. How come I can’t see any USB device on ALL0819 Utility’s tree view?  
Ans.:  
1. Check if every device is powered on and correctly connected (e.g. no loose wire).  
2. If so, even though the ALL0819 does support the USB device, the combination of a Full Speed 
device with a Low Speed Device (mouse, keyboard, etc) may cause compatibility issue. Please 
remove the USB device first, and then plug them back to clear this issue. Some Low Speed 
Device (such as mouse, keyboard, etc) may NOT be supported by this product. Please refer to the 
compatibility list for detailed information. 
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Q. OK, I have connected the USB device, now what? 
Ans.: Once a USB device is connected, simply use it the way you use it as if it were connected to 
your PC’s USB port. The usage is and should be the same. 
 
Q. I connected to the USB device but it doesn’t work?  
Ans.:  
1. Some USB devices require drivers to work properly. If so, please check if the specific driver for 

this device is correctly installed. To check this point, directly connect the USB device to your 
PC via a USB cable and see if the USB device works. If not, it means this USB device has 
problem in itself.  

2. USB devices that are in use for long time might suffer from component deterioration and hence 
cannot emit USB signal that is strong enough to interact with our ALL0819 Utility.  

3. Please note that some USB devices are not supported by ALL0819 (for example: USB HUB). 
If you connect the USB HUB to the ALL0819 product, It will only support the first USB device 
that connected to the USB HUB. The others will show unsupported device. Please also make 
sure your USB device is listed as supported in the compatibility list.  

 
Q. How come the software installer tells me to remove the previous version 
before installing on my 64- bit Windows Vista OS? 
Ans.: 64-bit Windows Vista has a very strict security policy that prevents the installer from 
automatically and completely remove previously installed program. Therefore, if a previous 
version or the same version software has been installed in 64-bit Windows Vista, the user must 
manually remove the previous version (from Control Panel => Programs and Features) before 
installing the software. 
 
Q. What does “Device not supported due to limited bandwidth” message mean? 
Ans.: USB 2.0 device by specification could be transmitting data at 480Mbps during operation, 
though in reality they are usually transmitting at a rate of 200+ Mbps. But this still by far surpasses 
the capability of the 10/100 Mbps bandwidth your network cable could provide, therefore the USB 
devices that require this much bandwidth to work could not be supported by this product. This 
warning message on the utility is just to inform you about this restriction. 
 
Q. Why sometimes I can’t successfully connect to the USB device on the tree 
view after speedy unplug and plug? 
Ans.: After unplugging USB device from ALL0819, the ALL0819’s USB/ACT LED might still remain 
light on for several seconds. Should any USB device be plugged during this very seconds, the 
ALL0819 may confuse with the devices and cause connection failure. So after unplugging USB 
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device, please only plug USB device again after the USB/ACT LED lights off. 
 

Q. Sometimes the ALL0819’s USB/ACT LED lights on even when no USB device 
is plugged. Is it normal?  
Ans.: It might happen when you plug the Ethernet cable to your PC directly and power on the 
ALL0819 without the USB device connected. Please do not plug the Ethernet cable during the 
power on. This phenomenon shouldn’t happen after booting, after rebooted you can connect the 
Ethernet cable and the USB device. It will work normally. 
 
Q. I forgot the password. What can I do? 
Ans.: On the product, there is a “RESET” button that allows you to reset all configurations back to 
the default settings. This will clean out the password you set. To do this,  

(1) Unplug Ethernet cord and USB device from ALL0819. 
(2) Push the “RESET” button for ≧ 3 seconds.  

The ALL0819’s “USB/ACT” and “ETH/ACT” LEDs will be off, and then turn on again. The device 
restarts itself. After restarted, the ALL0819’s IP configuration will return back to the default “DHCP” 
mode. The ALL0819’s password will return back to the default blank. Now, you can set your 
password again. 

3.2 Supported USB Devices 

Q. What USB devices does this product support? 
Ans.: Please refer to the compatibility list for detailed information. The devices on the list are those 
that have been tested and verified OK. Devices that are not on this list MAY NOT be supported by 
ALL0819. 
 
Q. How many USB printers can I connect to this product? 
Ans.: Depending on the product design, you should be able to connect one USB printer. Please 
consult the compatibility list for all the supported printers. 
 
Q. How many USB multi-function printers can I connect to this product? 
Ans.: Depending on the product design, you should be able to connect one USB multi-function 
printer. Please consult the compatibility list for all the supported multi-function printers. 
 
Q. Does this product support USB scanner? 
Ans.: Yes, it does. Depending on the product design, you should be able to connect one USB 
scanner. Please consult the compatibility list for all the supported USB scanners. 
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Q. Does this product support USB external HDD/storage? 
Ans.: Yes, it supports USB pen drive, card reader and USB HDD device. Depending on the 
product design, you should be able to connect one USB storage device. Most of the USB mass 
storage device on the market should be supported. 
 
Q. Does ALL0819 support USB external CD/DVD reader/recorder? 
Ans.: Yes, it supports USB external CD/DVD reader/recorder. Depending on the product design, 
you should be able to connect one USB external CD/DVD reader/recorder device. Most of the 
USB external CD/DVD reader/recorder on the market should be supported. 
 
Q. Does this product support USB webcam? 
Ans.:  Webcams are certainly supported as list in the compatibility list. But a USB 2.0 webcam 
can be transmitting data at 480 Mbps during operation. Though in reality they may not require so 
much bandwidth, the bandwidth they need is still far beyond the capability of the 10/100 Mbps 
bandwidth of the Ethernet interface. This product may not be able to support those webcams that 
require so much bandwidth for the obvious reason. Please consult the compatibility list supported 
device list for all the supported webcams. 
 
Q. The quality of the webcam capture seems worse when I connect it via this 
product? 
Ans.:  Depending on the product design, this product could control the USB 2.0 webcams, which 
originally work at a 480 Mbps connection, to function at lower speed to cope with the normal 
10/100 Mbps network connection bandwidth. It should be obvious that when working at lower 
speed, the webcam transmits less data each second hence the worse picture quality. 
 
Q. Does this product support USB Speaker/Mic? 
Ans.: Yes it does, but audio devices with large data stream (audio 5.1 or 7.1) might experience 
transmission instability due to a known limitation of this product. Please consult the compatibility 
list for all the supported USB audio devices. 
 
Q. How come my USB device does not work with ALL0819? 
Ans.: Though this product supports a lot of USB devices, it is not without limitation. Please consult 
the compatibility list for a list of all the supported devices. This list contains the devices that have 
been tested and verified to be compatible with this product. The devices that are not on this list 
may not be supported. 
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EC --- Declaration of conformity 

Germering, May 7, 2009 
For the following equipment: 
 

 

ALL0819 (USB LINK) 
 

The safety advice in the documentation accompanying the products shall be obeyed. The 

conformity to the above directive is indicated by the CE sign on the device. 

 

 

 

The ALLNET ALL0819 (USB LINK) conforms to the Council Directive of 2004/108/EC and Low Voltage Directive 

of 2006/95/EC.  

This equipment meets the following conformance standards: 

EMI:    EN 55022: 2006 

EN 61000-3-2: 2006 

EN 61000-3-3: 1995+A1: 2001+A2: 2005 

EMS:   EN 55024: 1998 + A1: 2001 + A2 : 2003 

IEC 61000-4-2: 1995+ A1: 1998+ A2: 2000 

IEC 61000-4-3: 2006 

IEC 61000-4-4: 2004 

IEC 61000-4-5: 2005 

IEC 61000-4-6: 2007 

IEC 61000-4-8: 1993+A1: 2000 

IEC 61000-4-11: 2004 

EN 60950-1:2006 

This equipment is intended to be operated in all countries. 

 

This declaration is made by 

 

Allnet GmbH  
Maistr. 2 ;  
D-82110 Germering  
Germany 
 

and can be downloaded from http://www.allnet.de 
 


